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Walk-Through

7777project
National Parks Info Pieces

Your client is the marketing manager 

for the National Parks Service 

(NPS). She wants to create a series 

of collateral pieces that will be used 

at tourism centers to lure potential 

visitors. She hired you to produce a 

one-sheet � yer that will be distributed 

in print and online, a rack card 

that can be placed in area hotels, a 

postcard that will be given away to 

park visitors, and a folio � le that will 

work on digital tablet devices.

� is project incorporates the following skills:

� Creating an XML � le using tagged frames and content

� Building a layout from imported XML content

� Controlling the structure of a layout to merge XML content 

into tagged frames

� Placing linked content into alternate layouts

� Creating interactive overlays for digital folio � les

� Creating alternate layouts for horizontal and vertical tablet 

orientations

� Creating a digital folio � le for tablet devices
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Project Meeting
We just heard from the printer that we can 
only use one spot color based on the quote 
he provided. � e logo uses two di� erent spot 
colors, and those are used throughout the 
layout as well. We decided to keep the metallic 
gold, but we need you to change the other one.

Now that it’s o�  cial, we’d also like to use the 
actual name “� e BLVD” rather than just 
saying “Downtown Lancaster” in most places.

Once you’ve � nalized the print � le, we need 
you to use the same content to create a PDF 
we can email to people, an e-book we can 
distribute, and an HTML � le that we can add 
into the content area of our Web site.

We have a lot of great pictures from Charlie 
Essers, a local photographer. We weren’t able to 
use them all in the print version, but we’d like 
to show as much as we can in the digital PDF 
and on the Web site.

We’d also like the form on the � nal page to 
actually function as a form in the � le we email 
to people. � ere’s no point making people 
print something out when they can just submit 
the form by email.

You have a lot of work to do, but InDesign 
has the tools to make all of this possible in 
the same layout. Of course, so many di� erent 
versions do require some careful planning and 
attention to detail.

� e only thing you won’t be able to establish 
in InDesign is the form distribution settings. 
We’ll have to set that up in Acrobat, but you 
can still de� ne the necessary form � elds right 
in the layout.

Layers are a great choice for managing 
interactive content that won’t work in the print 
layout. If you set everything up properly, you’ll 
be able to accomplish all four versions without 
saving separate � les for di� erent output media.

� Review the colors in the existing � le

� Search for and change speci� c content and 
attributes

� Export a color-managed PDF � le for 
commercial printing

� Prepare layers to manage static and 
interactive content in the same � le

� De� ne hyperlinks and other interactive 
elements as necessary for digital document 
delivery

� Create PDF form � elds

� Export an interactive PDF � le

� De� ne a table of contents for EPUB 
navigation

� Link images to text for EPUB and HTML 
export

� Create an interactive slideshow

� Export an e-book in EPUB format

� Export the document to HTML for Web 
publishing
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Stage 2	Creating	Interactive	Elements

The print file is now complete, but you still need to repurpose the content into several different 

versions for digital distribution — a common assignment in the professional market. To complete this 

type of repurposing, you need to understand the options and capabilities of each format.

You already know that the PDF format can contain all of the elements — fonts, images, etc. — 

required to create high-quality printing. Digitally distributed PDF files support interactive elements 

and multimedia, which are not possible in static print jobs. 

If you completed Project 5: Ireland Travel Brochure, you also saw that you can create interactive 

page transitions for files that are delivered digitally. Those transitions are only one of the interactive 

and multmedia elements that are supported by the PDF format. In this stage of the project, you are 

going to create an interactive table of contents, hyperlinks, a slideshow of images, and a form that 

users can fill out directly in Adobe Acrobat. InDesign allows you to create all of these elements directly 

in the layout, without the need for additional software.

Create Versions with Layers

Rather than saving and editing multiple versions of the same basic file, you are going 

to use layers to identify elements that function properly for all output versions, as well 

as isolating objects that are only appropriate for certain formats.

 1. With boulevard.indd open, navigate to Page 1 of the layout.

 2. In the Layers panel (Window>Layers), double-click the Layer 1 name to 

open the Layer Options dialog box.

The default in every file is named “Layer 1”, which is not terribly useful when you use 

multiple layers. Descriptive names are far better for any asset — including layers.

 3. Change the Name field to Common Elements, then click OK.

 4. Click the Create New Layer button at the bottom of the Layers panel.

 5. Double-click Layer 2 in the Layers panel. Change the layer name to  

Static Print and click OK.

 6. In the Layers panel, click the arrow to the left of the Common Elements 

layer to expand it.

Layers are also useful 

for designing die-cut 

documents, which are 

cut in non-rectangular 

shapes or contain an area 

cut out within the page.  

The tab on a manila 

folder and a folded 

carton are two examples 

of die-cut jobs.

Note:
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Find and Change ObjeCt attributes

In addition to searching for specific text formatting attributes, you can also find and 
replace specific object formatting attributes. In this exercise you will replace all brown-
stroked frames with the gold spot color.

 1. With boulevard.indd open, open the Find/Change dialog box if it is not 
already open.

 2. Click the Object tab to display those options. 

 3. In the Type menu, choose All Frames.

You can limit your search to specific kinds of frames, or search all frames.

Click this button to open 
the Find Object Format 
Options dialog box.

Click this button to open 
the Change Object Format 
Options dialog box.

 4. Click the button to open the Find Object Format Options dialog box.

You can find and change any formatting attributes that can be applied to a frame.

 5. Display the Stroke options and click the Pantone 7554 C swatch. 

 6. Click OK to return to the Find/Change dialog box.

 7. Open the Change Object Format Options dialog box and choose the 
Pantone 875 C swatch in the Stroke options.

 8. Click OK to return to the Find/Change dialog box.

Project Goals
Each project begins with a clear description 
of the overall concepts that are explained 
in the project; these goals closely match the 
different “stages” of the project workfl ow.

The Project Meeting
Each project includes the client’s initial 
comments, which provide valuable 
information about the job. The Project 
Art Director, a vital part of any design 
workfl ow, also provides fundamental 
advice and production requirements. 

Project Objectives
Each Project Meeting includes a 
summary of the specifi c skills required 
to complete the project.

Step-By-Step Exercises
Every stage of the workfl ow is 
broken into multiple hands-on, 
step-by-step exercises.

Visual Explanations
Wherever possible, screen 
shots are annotated so you 
can quickly identify important 
information.

Real-World Workfl ow 
Projects are broken into logical lessons or 
“stages” of the workfl ow. Brief introductions at 
the beginning of each stage provide vital foun-
dational material required to complete the task.
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Project 4: Realtor Collateral Booklet

Project Review

 1. Briefl y explain the difference between facing pages and non-facing pages.

 2. Briefl y explain the difference between reader’s spreads and printer’s spreads.

 3. Briefl y explain the advantages and disadvantages of nesting text-formatting styles.

 1. _______________ have inside and outside 

margins instead of left and right margins.

 2. When _______________ is active, InDesign 

automatically adds pages to accommodate 

an entire story that is placed in a primary text 

frame. 

 3. A local formatting override is indicated by 

_______________ next to the style name in the 

Paragraph Styles panel. 

 4. A negative fi rst-line indent is called a(n) 

_______________. 

 5. A(n) _______________ is a single line of a 

paragraph at the end of a column. 

 6. A(n) _______________ is a single line of a 

paragraph at the top of a column, or a very 

short (one-word) last line of a paragraph.

 7. _______________ in the Paragraph Style 

Options dialog box can be used to force a 

paragraph to begin in the next linked frame. 

 8. _______________ fonts can store more than 

65,000 glyphs (characters) in a single font fi le; 

the same font fi le works on both Macintosh 

and Windows.

 9. You can use the _______________ option to 

create a parent/child relationship between two 

styles, in which changes made to the parent 

style refl ect in the child style as well.

 10. _______________ is the process of arranging 

pages on a press sheet so, when folded 

and trimmed, the pages of a job appear in the 

correct order.
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Use what you learned in this project to complete the following freeform exercise. 
Carefully read the art director and client comments, then create your own design to meet the needs of the project.
Use the space below to sketch ideas; when fi nished, write a brief explanation of your reasoning behind your fi nal design.

Portfolio Builder Project

� ese pieces are exactly what I had in mind. 
When I pitch the project to my superiors, I want 
to be able to show them all the same pieces for at 
least two di� erent parks. � at way the committee 
will see how di� erent colors and pictures will a� ect 
the individual pieces, but still have a consistent 
look and feel. I’ve sent you the text and images for 
Yosemite for this second set of � les.

I’d also like to see one additional layout — 
redesigning our park map brochure to include this 
same content, but also with a large map of the 
speci� c park. We already have the maps, but I’ll 
have to � nd the � les for you; for now just leave 
space on the inside of the brochure.

� e client is very pleased with the pieces you 
have designed to promote tourism in the 
national parks. Before she presents the project 
to her director for approval, she would like to 
have the same pieces for at least one other park. 

To complete this project, you should:

� Create the � yer, rack card, postcard, and 
 iPad layouts for Yosemite National Park. 
Use the images and text that are provided in 
the ID6_PB_Project7.zip archive on the 
Student Files Web page.

� Create one additional layout for a letterfold 
brochure that will include the same 
content as the other pieces. � e inside of 
the brochure should have only the park 
name and space for a map of the park. (If 
you completed Project 5: Ireland Travel 
Brochure, you can use the same basic 4×9″ 
template that you created in that project.)

Project Summary

482 Project 7: National Parks Info Pieces

Repurposing the same content in multiple di� erent layouts is becoming increasingly common in the 

design world. � is project explored two di� erent methods for repurposing content, both for multiple 

print formats and for digital media.You used unstructured XML to drag speci� c types of content into a layout, and you used a 

more structured approach to automatically place content into tagged frames of a di� erent layout. By 

maintaining a link to the XML � le, you were able to automatically update the placed content to re� ect 

changes in the text. 
You also used the content sharing and alternate layout capabilities that are built into InDesign 

CS6 to create di� erent layouts from existing content. You also added interactive overlays to take better 

advantage of the capabilities of digital media.

Use unstructured XML to create a layout 
from selected content

Use structured XML to create a layout 
from all content

Use content sharing tools to create a layout for digital media

Create an interactive overlay for digital media

Create alternate layouts for different device orientations.
Create a digital folio for tablet display
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The Animation panel offers a variety of options for controlling the details of an animation.

Event(s) defines what event triggers the animation:

•	 On	Page	Load,	the	default,	means	the	animation	plays	

when the page is opened in the SWF file. 

•	 On	Page	Click	triggers	when	the	page	is	clicked.	

•	 On	Click	(Self)	and	On	Roll	Over	(Self)	trigger	the	

animation	when	the	object	itself	is	clicked	or	moused	

over,	respectively.	If	you	choose	On	Roll	Over	(Self),	you	

can	also	select	Reverse	On	Roll	Off,	which	reverses	the	

animation	when	the	mouse	moves	off	the	object.

Although	you	will	learn	about	button	events	later	in	this	

project,	you	should	understand	that	you	can	also	create	a	

button	that	triggers	the	animation.	In	this	case,	On	Button	

Event	is	added	to	the	Event(s)	menu.

You	can	click	Create Button Trigger to define an existing 

object	that	will	trigger	the	animation.	After	you	click	Create	

Button	Trigger,	click	the	object	that	you	want	to	trigger	the	

animation.	The	clicked	object	is	converted	to	a	button	and	

the	Buttons	and	Forms	panel	opens.

The Buttons and Forms panel automatically 

opens to control the new button’s behavior.

Click Create Button Trigger, then click the 

object you want to trigger the animation.
This object is 

animated.

Duration	defines	how	much	time	it	takes	for	the	animation	

to	play	(start	to	finish).

Play	defines	the	number	of	times	the	animation	is	played.	

Check	the	Loop	option	to	play	the	animation	repeatedly.

Speed controls the change in animation speed over time. 

•	 Using	None,	the	animation	speed	is	a	steady	rate.

•	 Using	Ease	In,	the	animation	speeds	up	over	time.	

•	 Using	Ease	Out,	the	animation	slows	down	over	time.

If	you	expand	the	Properties section	of	the	Animation	panel,	you	can	define	additional	options.	

If	you	look	closely,	one	end	of	the	motion	path	includes	an	

arrow,	indicating	the	direction	the	object	will	travel.	You	can	

change	the	direction	using	the	Animate menu:

•	 From	Current	Appearance	uses	the	object’s	current	

properties	as	the	animation’s	starting	point.	

•	 To	Current	Appearance	uses	the	object’s	properties	as	

the	animation’s	ending	point.	

•	 To	Current	Location	uses	the	current	object’s	properties	

as	the	starting	point	of	the	animation	and	the	object’s	

position as the ending point. 

The	effect	of	the	Rotate,	Scale,	and	Opacity	properties	

depends	on	which	option	is	selected	in	the	Animate	menu:

•	 If	From	Current	Appearance	or	To	Current	Location	is	

active,	the	properties	define	the	ending	appearance	of	

the animated object.

•	 If	To	Current	Appearance	is	active,	the	properties	define	

the starting appearance of the animated object.

You	can	use	the	animation proxy	to	get	a	rough	idea	of	

how	your	properties	affect	the	animation.	

This arrow indicates 

that the object will 

move to this position.Click here to show 

the animation proxy 

on the motion path.

The proxy shows the ending 

rotation and scale defined in 

the Animation panel.
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The Animation Panel in Depth

356 Project 6: Digital Layout Variations

EnablE Track changEs 
In many cases, multiple users collaborate on a single document — designers, editors, 
content providers, and clients all go back and forth throughout the design process. 
Each person in the process will request changes, from changing the highlight color 
in a document to rewriting the copy to fit in a defined space. Because the words in a 
design are a vital part of communicating the client’s message, tracking text changes 
throughout the process can be useful to make sure that all changes are accurate and 
approved before the job is finalized.

 1. With boulevard.indd open, use the Type tool to place the insertion point 
in any story.

 2. Choose Type>Track Changes>Enable Tracking in All Stories.

The Track Changes feature can be activated to monitor text editing during development. 
This allows multiple users to edit the text without permanently altering that text until 
the changes have been reviewed and approved or rejected. (After you have made all the 
changes in this stage of the project, you will review and finalize those changes.)

These options are 
not available unless 
the insertion point 
is currently placed.

 3. Open the Track Changes pane of the Preferences dialog box. Make sure the 
Added Text, Deleted Text, and Moved Text options are checked.

 4. Choose Underline in the Added Text Marking menu.

The Marking options add a visual indicator (strikethrough, underlining, or outlining)  
so you can more easily identify text that is affected by the Track Changes function. 

 5. Choose Red in the Deleted Text Background menu.

The Text Color options 
define the color of 
highlighting that will 
identify each type of 
change. All three options 
default to the same color; 
changing the color for 
Deleted Text will make it 
easier to identify this type 
of change when you review 
the corrections at the end of 
this stage of the project.

 6. Click OK to return to the document, then save the file and continue to the 
next exercise.

Remember, preferences 
are accessed in the 
InDesign menu on 
Macintosh or in the Edit 
menu on Windows.

Note:

Some text issues, 
however, have little to 
do with typography and 
more to do with “user 
malfunction” — common 
errors introduced by the 
people who created the 
text (most often, your 
clients). Regardless of 
how knowledgeable or 
careful you are, some 
problems will inevitably 
creep into the text 
elements of your layouts. 

Note:

It is very easy to 
make a mistake when 
spellchecking, so it’s a 
good idea to check the 
Include Deleted Text 
When Spellchecking 
option at the bottom of 
the Preferences dialog 
box.

Note:

InDesign Foundations
Additional functionality, related tools,  
and underlying graphic design concepts  
are included throughout the book.

Advice and Warnings
Where appropriate, sidebars  
provide shortcuts, warnings, or 
tips about the topic at hand.

Visual Summary
Using an annotated version of the 

finished project, you can quickly  
identify the skills used to complete 

different aspects of the job.

Project Review
After completing each project, you  
can complete these fill-in-the-blank and 
short-answer questions to test your under-
standing of the concepts in the project.

Portfolio Builder Projects
Each step-by-step project is accompanied 
by a freeform project, allowing you to 
practice skills and creativity, resulting in an 
extensive and diverse portfolio of work.
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 3 HeartSmart Newsletter

� Working with 
Templates

� Working with Styles

� Working with 
Tables

� Prefl ighting 
and Packaging 
the Job
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 2 Festival Poster

� Building Graphic 
Interest

� Importing and 
Formatting Text

� Graphics as 
Text and Text as 
Graphics

� Outputting the 
File
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 1 Letterhead Design

� Setting up the 
Workspace

� Creating Basic 
Page Elements

� Placing External 
Images

� Creating and 
Formatting Basic 
Text 

� Printing InDesign Files

Th e Against Th e Clock Portfolio Series teaches graphic 
design software tools and techniques entirely within 
the framework of real-world projects; we introduce and 
explain skills where they would naturally fall into a real 
project workfl ow. 

Th e project-based approach in Th e Professional 
Portfolio Series allows you to get in depth with the 
software beginning in Project 1 — you don’t have to read 
several chapters of introductory material before you can 
start creating fi nished artwork. 

Our approach also prevents “topic tedium” — in 
other words, we don’t require you to read pages and pages 
of information about text (for example); instead, we 
explain text tools and options as part of larger projects (in 
this case, beginning with placing text on a letterhead). 

Clear, easy-to-read, step-by-step instructions walk 
you through every phase of each job, from creating a new 
fi le to saving the fi nished piece. Wherever logical, we also 
off er practical advice and tips about underlying concepts 
and graphic design practices that will benefi t you as you 
enter the job market.

Th e projects in this book refl ect a range of diff erent 
types of InDesign jobs, from creating a client letterhead 
to implementing a newsletter template to compiling a 
multi-chapter book. When you fi nish the eight projects 
in this book (and the accompanying Portfolio Builder 
exercises), you will have a substantial body of work that 
should impress any potential employer.

Th e eight InDesign CS6 projects are described briefl y 
here; more detail is provided in the full table of contents 
(beginning on Page viii).

Projects at a Glance
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 4 Realtor Collateral Booklet

� Working with 
Master Pages

� Controlling the 
Flow of Text

� Outputting 
Variations 
of Files
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 7 National Parks Info Pieces

� Working with XML

� Creating Alternate 
Layouts
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 8 Multi-Chapter Booklet

� Combining 
Documents into Books

� Building a Table of 
Contents 

� Building an Index 

� Exporting Book 
Files

� Merging Data 
into an InDesign 
Layout
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 6 Digital Layout Variations

� Controlling Color 
for Output

� Creating Interactive 
Elements

� Creating EPUB and 
HTML Files
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 5 Ireland Travel Brochure

� Building a 
Folding Template

� Advanced Frame 
Options

� Advanced Text 
Formatting

Our goal in this book is to familiar ize you with the majority 
of the InDesign tool set so you can be more productive and 
more marketable in your career as a graphic designer.

It is important to keep in mind that InDesign is an 
extremely versatile and powerful application. Th e sheer 
volume of available tools, panels, and features can seem 
intimidating when you fi rst look at the software interface. 
Most of these tools, however, are fairly simple to use with a 
bit of background information and a little practice. 

Wherever necessary, we explain the underlying concepts 
and terms that are required for understanding the software. 
We’re confi dent that these projects provide the practice you 
need to be able to create sophisticated artwork by the end of 
the very fi rst project.
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